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Workflow Studio

Workflow Studio provides an easy-to-use, graphical interface for workflow composition that
virtually eliminates scripting. Workflow Studio acts as the glue across the IT infrastructure
allowing administrators to easily tie technology components together via workflows.
Workflow Studio is built on top of Windows® PowerShell™ and Windows Workflow
Foundation.

This section of the library provides up-to-date product information about Workflow Studio,
including the following featured topics.

Introduction Review conceptual information about Workflow Studio

About Workflow Studio Release
2.5

Read about new features

System Requirements Read about system requirements and supported
systems

Known Issues for Workflow
Studio 2.5

Get information about known issues

Installing and Configuring
Workflow Studio

Install, configure, and run Workflow Studio

Getting Started with Workflow
Studio

Follow this guided tutorial to learn the basics about
importing, testing, and scheduling workflows

Getting Started with Workflow
Studio Designer

Follow this guided tutorial to learn the basics about
creating a workflow.

Creating and Managing Jobs Create, manage, and view Workflow Studio categories,
projects, and jobs

Creating and Editing Workflows Create and edit workflows

Securing Operations and Data Secure runtimes, workflows, and jobs

Workflow Studio Development Learn about creating custom activity librarires and
using PowerShell for automation
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About Workflow Studio Release 2.5

Workflow Studio Release 2.5 includes new and enhanced features and activities.

Security on workflows and jobs

Security permissions can now be applied to workflow categories and to jobs. Workflows are
protected through permissions that are applied to the categories containing the workflows.
Permissions include rights such as "Workflow Admin" and "Jobs Admin." A workflow category,
by default, has security permissions set to "Full Control" for the Everyone group.

Jobs are protected through permissions that are applied to individual jobs. When a
workflow is deployed, Workflow Studio assigns the job the same permissions as are on the
category containing the workflow. You can then change the permissions on the job. For
information on security, see Securing Operations and Data.

Global property display name and description

You can now provide descriptive information with global properties to help those running a
workflow or creating a job understand the purpose of the global properties. You can specify
a Display Name which will appear in the Start Workflow dialog, the Create Job wizard, and
the Job Inspection window instead of the Name. (Unlike a global property Name, a Display
Name can contain spaces.) You can also specify a Description which will appear as a tooltip
in the Start Workflow dialog and the Create Job wizard.

Performance improvements and other updates

● The overall performance of workflow execution and the Workflow Studio interface has
improved. Changes include a SQL-based tracking and persistence service, SQL-based
runtime data store, Authorization Manager (AzMan) optimization, and PowerShell-based
workflow optimization.

● Support for multiple outputs per workflow instance, enabling you to store and retrieve
only the outputs you need.

● Support for PowerShell version 2 and for .NET version 4.0 (in addition to version 3.5,
Service Pack 1).

New Activity Libraries

● Hyper-V Activity Library: Activities to create and manage Hyper-V VMs, add storage
repositories, and automate the process of taking snapshots, backing up VMs, and
backing up VM metadata for site migration and disaster recovery. These activities also
automate the installation and update of tools on guest Hyper-V VMs.

● SQL Activity Library: Activities to run SELECT, INSERT, UPDATE, and DELETE commands
on a SQL Server database.

New and updated activities



● SNMP activities (in the Networking activity library) now support SNMP version 3 (in
addition to versions 1 and 2).

● XenApp Activity Library: New activities that support application self-service workflows
by adding and removing application accounts.

● XenDesktop Activity Library: New activities that support VM-based desktop groups by
adding users to an existing desktop group, retrieving a list of hosted VMs, configuring
how a hosting infrastructure manages VMs that are in a VM-based desktop group, and
connecting to a hosting infrastructure management server.

● XenServer Activity Library: New activities that support desktop upgrades by setting,
modifying, and retrieving the virtual CPUs and RAM allocated to a VM.

New PowerShell cmdlets

● New PowerShell cmdlets have been added to support new functionality: Get-JobSD,
Set-JobSD, Get-WorkflowOutput, and Set-CategorySecurity.

About This Release
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Introduction

Workflow Studio, a member of the Citrix Delivery Center product family, is an IT process
automation solution that enables you to create, schedule, run, and manage workflows. The
workflows tie technology components together, mechanize repetitive configuration
processes, and coordinate condition-based triggers for administrative tasks.

Workflow Studio integrates components in the Citrix Delivery Center enabling the IT
infrastructure to operate as a dynamic delivery platform. Workflow Studio includes
components that enable you to automate XenDesktop, XenApp, XenServer, and NetScaler
operations.

The following topics provide background information on Workflow Studio.

About Citrix Workflow Studio Read about the types of automation provided by
Workflow Studio

Source Components of
Workflow Studio

Read about the components on which Workflow Studio
is built and extends

About Activity Libraries Read about activity libraries, the building blocks of
workflows

To access the Citrix Developer
Network

Access a wealth of information and tools on the Citrix
Developer Network

About Workflows and Jobs Get conceptual information on workflows and jobs

About the Database Get conceptual information on data stores

About the Security Role Store Get conceptual information on the security role store
For access to articles, blogs, video tutorials, sample workflows, and other information, go
to the Citrix Workflow Studio Developer Network website at
http://community.citrix.com/cdn/wf.

http://community.citrix.com/cdn/wf
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About Citrix Workflow Studio

Citrix Workflow Studio is built on the Microsoft .NET Framework, Windows Workflow
Foundation, and Windows PowerShell. If you use Workflow Studio to deploy, manage, and
run workflows, you do not need to know anything about those components. However, if you
are already a Visual Studio or PowerShell user, you will find many aspects of Workflow
Studio to be familiar. You can even use PowerShell cmdlets to schedule and run workflows
outside of Workflow Studio.

Through a graphical workflow designer, you can build full automation of your business
and/or IT processes. The graphical interface virtually eliminates scripting. Typical usage
scenarios include the following:

● Dynamic resource allocation

Create new virtual resources dynamically to respond to capacity needs, on-premise or
off-premise by integrating with cloud providers like Amazon EC2.

● Power management

Power on/off physical servers based on usage; manage virtual machines; power on/off
the physical host.

● User provisioning

Simplify the process of provisioning a new user by combining all the back-end steps into
a single workflow. For example, create a user in Active Directory, create a new virtual
desktop VM, and then add the VM to Citrix Provisioning Server/XenDesktop.

● Disaster recovery

Automatically respond to equipment failures by reconfiguring network equipment,
moving virtual machines, and so on.

● Product automation

Automate any combination of steps from product management consoles into a single,
reusable workflow.

Workflow Studio is geared specifically for automating IT processes through workflows. You
use Workflow Studio for the following types of automation:

● On-demand automation

You can run a workflow at any time on-demand.

● Schedule-based automation

You can run a workflow according to a schedule. To schedule a workflow in Workflow
Studio, you create a job for it.



● Event-driven automation

You can deploy workflows that run automatically based on a condition or set of
conditions.

You create and unit-test workflows in Citrix Workflow Studio Designer, which is launched
from the Workflow Studio management interface. The management interface is used to
schedule, manage, and monitor workflow jobs.

About Citrix Workflow Studio
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Source Components of Workflow Studio

Citrix Workflow Studio is built on top of the following Microsoft components:

● Windows Workflow Foundation

Windows Workflow Foundation is a part of the .NET Framework that enables developers
to create workflow-enabled applications. Citrix Workflow Studio uses Windows
Workflow Foundation as the workflow engine, hosting it in a Windows service referred
to as the Workflow Runtime (WFR). Windows Workflow Foundation also provides the
visual designer and the base activity library functionality. Workflow Studio extends
each of these to target an IT Professional. Workflow Studio also melds Windows
Workflow Foundation with PowerShell, providing native support for PowerShell
activities.

● Windows Presentation Foundation

Windows Presentation Foundation is the platform for the Workflow Studio interface, a
rehosted and extended version of the Visual Studio Workflow Designer. Citrix Workflow
Studio provides additional functionality targeted at making the development experience
much easier. The extensions allow Workflow Studio to be effectively used by
non-developers and also provide native support for PowerShell-based activities.

● Windows PowerShell

Windows PowerShell is a core infrastructure component, serving as the basis for the
Workflow Studio interface and automation features. Workflow Studio provides native
support for PowerShell-based activities.

In addition, a workflow created in Workflow Studio can be deployed and scheduled
outside of Workflow Studio by any client application calling our workflow deployment
and scheduling Microsoft PowerShell cmdlets.

● Windows Communication Foundation

Windows Communication Foundation is used to manage all of the communication
between the Workflow Studio interface and each installed workflow runtime.

● Authorization Manager

Authorization Manager is used as a central store where Workflow Studio stores data
such as role-based security configuration data and workflow metadata, providing
granular control over access to workflows.

● Microsoft SQL Server

Microsoft SQL Server is used as the central store for workflow and job data, runtime
computer information, workflow job history (tracking), and workflow job state
(persistence).
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About Activity Libraries

Activities, the building blocks of workflows, expose functionality to workflow developers.
Activity libraries are built on top of PowerShell and .NET APIs to provide access to the
underlying products. Citrix provides activity libraries that integrate products such as Citrix
XenApp, XenDesktop, XenServer, and NetScaler. Citrix also provides general purpose
activity libraries developed by Microsoft and extended by Citrix to support many Windows
systems. For example:

● The Active Directory and Group Policy libraries provide the building blocks needed to
provision users and manage rights.

● The Networking library provides the ability to remotely shut down your Windows servers
and desktops. It also supports WakeOnLAN for power on technology.

● The Windows and WMI libraries offer a broad range of activities for typical Windows
operating system management: Reading from the Windows Registry, querying
performance counters, manipulating files, and accessing any data exposed via WMI.

● The PowerShell library exposes the functionality of PowerShell and, in particular, allows
you to import and export CSV files.

These activities make accessing WMI, VMScript, and PowerShell easy for non-developers. We
also provide an SDK that can be used with Visual Studio to develop custom activities.

For information about installing, finding updates to, and getting help with activity libraries,
refer to To install activity libraries.
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To access the Citrix Developer Network

The Citrix Workflow Studio Developer Network website provides access to articles, blogs,
video tutorials, sample workflows, and other information. You can access the site from
within the Workflow Studio management interface as follows.

1. In the Workflow Studio window navigation pane, click the Community tab. The
Workflow Studio page of the Citrix Developer Network opens in the information pane.

2. In the Community tree view, click a category name such as Workflows. An RSS viewer
appears in the information pane, providing searchable access to all workflows posted on
the Citrix Developer Network.

3. To filter the list, start typing a term in the Search box.

4. Click an entry to view a description of the entry and a download link for it.

5. Click the download link and navigate to the location where you want to save the item.

http://community.citrix.com/display/wf
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About Workflows and Jobs

Workflows

A workflow is a compiled set of code that performs tasks. A workflow is comprised of one
or more workflow source files, including .xoml, .cs, and .xml files. A compiled workflow
project exists as a .dll file, sometimes with supporting .xml files. Workflow source files
and compiled workflow project files are stored in the central data store. For details
about workflow source files, see Workflow Source Files

Workflow Runtime

A workflow runtime is a light-weight and extensible engine that executes the activities
which make up a workflow. When you install Workflow Studio, a workflow runtime is
created for your localhost. You can use that workflow runtime to run multiple jobs. If
you need to run workflows using different user credentials, you can create other
workflow runtimes on your computer. You can also create workflow runtimes on remote
servers. You specify the runtime to be used to run a workflow when you run it on
demand or when you create a job for it.

Jobs

A job is an instance of a workflow that is scheduled or deployed to a workflow runtime. A
job consists of workflow project files, workflow parameters, and metadata for
scheduling, security, and authentication.

Related Information

Management Interface for Workflows and Jobs

General Steps for Using Imported Workflows

To create a job
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Management Interface for Workflows and
Jobs

Administrators use the Workflow Studio interface to manage workflows and jobs (as well as
security roles). The Workflows tab (in the left pane) contains a tree view of workflow
categories. The workflows for a selected category appear in the middle pane. The
commands that can be performed on workflows are available in the right pane, labeled
Actions.

The Jobs tab contains a tree view of jobs. In the jobs tree, jobs are organized by the
servers on which they run. Before you can create a job or use the Jobs or Runtime Security
tabs, you are prompted to add a server to the tree. You will likely add a server for your
localhost and possibly one or more other servers for deploying jobs remotely.

All jobs that have been run on demand, scheduled, or deployed appear in the middle pane.
The commands that can be performed on jobs are available in the Actions pane. You can
also right-click a job and choose Open to access the Job Inspection window where you can
view the tracking data for a running workflow.
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General Steps for Using Imported
Workflows

When you install Workflow Studio, there are no available workflows or jobs. The following
general steps describe the process for importing a workflow and creating a job for it:

1. Create a category for the workflow.

Workflow Studio organizes workflows into categories. You must create at least one
category before you can create or import a workflow. For example, you might have
categories such as Audits, Backups, and Installs, with other categories nested under
them. See To create a workflow category.

2. Import the workflow.

Before you can run or schedule a workflow in Workflow Studio, you must import it into
Workflow Studio. See To import a workflow.

3. Test the workflow on your computer.

You should always test a workflow by running it on demand before you schedule it to
run. Testing a workflow enables you verify that the parameters you plan to specify for
the job work as expected. See To test a workflow.

4. Add a server to Workflow Studio.

Before you can create a job in Workflow Studio, you must specify the server(s) on which
you plan to run the job. See To specify a server for running jobs.

5. Create a job for the workflow.

To run a workflow on a schedule, you create a job for it. See To create a job. When you
create the job, you specify:

● The parameters needed to run the workflow so that it can run unattended.

● The schedule for the job.

● The workflow runtime to be used for the job.
After you create a job, you can use the Workflow Studio interface to:

● Change a job’s parameters, schedule, and target workflow runtime. See To change job
properties.

● Temporarily disable a job and then re-enable it. See To disable/enable a job.

● View job history. See To view job details and event history.

● Delete obsolete jobs. See To delete a job.

http://support.citrix.com/proddocs/index.jsp?lang=en&topic=/workflow-25/ws-manage-jobs.html#task_9266BF829B1E4C3DB40141DE16553023
http://support.citrix.com/proddocs/index.jsp?lang=en&topic=/workflow-25/ws-manage-jobs.html#task_EECE5E8E871241339176E550DC3BCFF1
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Workflow Source Files

A workflow is a set of source files that are compiled into a .dll. The source files are
necessary to edit the workflow (in the Workflow Studio Designer) and the binary is
necessary to execute the workflow (in the runtime engine).

A workflow contains the following source files:

● workflowName.wfsp

An XML representation of the project references. This is the file that is loaded by
Workflow Studio.

● workflowName.xoml

The XAML file that defines the visual representation of the workflow. It specifies the
activities to be loaded and executed as well as an ordered representation of how the
workflow will execute.

● workflowName.xoml.cs

The code-beside file that defines any custom code that is executed along with the
activities.

● AssemblyInfo.cs

The standard Visual Studio file used to define the version for the workflow.

● sn.key

A stock signing file used to provide each workflow a strong name.

When you run a workflow, Workflow Studio compiles those files into a versioned, binary
workflow. When you run a workflow from the designer, the first step is a temporary build
process which creates workflow assemblies on your computer. After the workflow
completes running, the temporary build files are removed from your computer (regardless
of the success or failure of the run).
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About the Database

The Workflow Studio database uses Microsoft SQL Server and supports both SQL Server and
SQL Express. The database contains core data that is common among different user console
instances such as workflow and job data, runtime computer information, workflow job
history (tracking), and workflow job state (persistence). To log on to Workflow Studio, a
Workflow Studio user must be an administrator on the database for Workflow Studio.

SQL Server security is used to restrict access to tables and procedures in the database.
Workflow Studio includes pre-defined security roles that include database security
permissions, as described in About Security Roles. The security role store is described in
About the Security Role Store.

Workflow Studio supports named database instances. When you log on to Workflow Studio,
you specify the database in the form server\databaseInstance. You include the database
instance only if you are using SQL Express or a named instance with SQL Server.

Related Information

About the Security Role Store



20

About the Security Role Store

Security role data is stored either in Active Directory or in a local XML file. You must create
a security role store in Active Directory if you plan to use remote runtimes. The Workflow
Studio installer and configuration wizard both allow you to create a security role store in
Active Directory.

Workflow Studio uses the Windows Authorization Manager (AzMan) as the interface to
security role data regardless of where it is stored. When security role data is stored in
Active Directory, Workflow Studio also caches security role data to local XML files for
consumption by local runtimes. A workflow runtime authorizes incoming requests against
the security role data.

The XML AzMan role store cache is managed by the WorkflowADRoleService. You specify
credentials for the WorkflowADRoleService during installation or configuration. The service
must run under a domain account that has rights to query the role store in Active Directory.
WorkflowADRoleService first queries Active Directory for role store data (through AzMan
APIs) and, if that query fails, the service uses the local cache data and logs an error event
to the Windows Application Event Log.

The WorkflowADRoleService query schedule configuration is stored in a .config file. If a
scheduled synchronization fails to get data from Active Directory, an error event is logged
to the Windows Application Event Log.

Each time that WorkflowADRoleService synchronizes Active Directory and the XML role store
cache, the service also replaces/resets the ACLs on the XML cache file so that only
LocalSystem and the domain account that the service is running under can access the file.

Related Information

About the Database
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Known Issues for Workflow Studio 2.5

Contents
● Upgrading to Release 2.5

● Finding Documentation

● Known Issues

● Issues Fixed in this Release

Upgrading to Release 2.5
As of Release 2.5, Workflow Studio runtime information is stored in an SQL database instead
of an XML file. As a result of this performance improvement, information about jobs
executed on a runtime as well as deployment history is lost when you upgrade to Release
2.5.

To upgrade to Release 2.5

1. Obtain the Workflow Studio installation ISO image from
http://www.citrix.com/wfsinsider.

2. Use Add or Remove Programs to uninstall the Activity Libraries and then to uninstall
Workflow Studio. (You must uninstall the Activity Libraries first.)

3. Use the setup.exe for Release 2.5 to install Workflow Studio.

4. On the Workflow Database page of the Workflow Studio Configuration wizard, after you
click Connect two buttons appear: Upgrade Database and Re-create Database. Be sure
to click Upgrade Database if you want to retain the database that contains your
workflows.

5. After you finish configuring Workflow Studio, use the setup.exe for Release 2.5 to
install the Activity Libraries.

Finding Documentation
In addition to the information provided on this site, documentation is also available in the
Workflow Studio area of the Citrix Developer Network.

To access help from the Workflow Studio window:

http://www.citrix.com/wfsinsider
http://community.citrix.com/cdn/wfs


● Click the Workflows, Jobs, or Runtime Security tabs and then click Getting Started in
the Actions pane to view quick help. From the quick help pages you can also access
web-based tutorials and help.

● Click the Community tab to access the Citrix Workflow Studio Developer Network. Click
links in the "Inside" box to access articles, blogs, sample workflows, and other
information.

To access help from the Workflow Studio Designer window:

● Choose Help > Help Contents.

● Click an activity in the Activities tab to display a description of it at the bottom of that
tab.

● Click a property in the properties pane to display a description of it at the bottom of
that pane.

Workflow Studio Issues
Workflow Studio Configuration wizard will not create database if name contains
double-byte characters

Although the Workflow Studio Configuration wizard will allow you to enter the double-byte
characters, the Review Changes page will indicate that the database creation failed. [1008]

Download link for Streaming Profiler does not work in Internet Explorer 6

The download link for Citrix Streaming Profiler in the Activity Library installation wizard
does not work in Internet Explorer 6. The download link works in Internet Explorer 8 and
above. [1531]

Performance issues possible when Workflow Studio does not have Internet access

When Workflow Studio does not have Internet access, runtimes can timeout and fail when
Workflow Studio attempts to look up the certificate revocation list. You can work around
this issue in any of the following ways:

● Allow access to the following sites: http://CSC3-2004-crl.verisign.com/CSC3-2004.crl
and http://crl.verisign.com/pca3.crl

● Set up a local hosts entry to redirect crl.verisign.com and CSC3-2004-crl.verisign.com to
127.0.0.1 to avoid the DNS lookup timeouts.

● Download and install the two .crl files (listed in the first bullet above) manually from
Verisign. Important: You will need to do this every couple of months when they expire.
For information on manually importing a CRL, refer to
http://technet.microsoft.com/en-us/library/aa996972%28EXCHG.65%29.aspx.

● Disable certificate checking as described in this article:
http://support.microsoft.com/kb/936707. You will need one configuration file for each
executable in %PROGRAMFILES%\Citrix\Workflow Studio.

Known Issues
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● Disable certificate checking in Internet Explorer by clearing the checkbox for the
"Check for publisher's certificate revocation" Security option in the Internet Options >
Advanced tab. This workaround must be performed on each computer running
Workflow Studio. [763]

Error indicator remains when you delete and re-add an activity

If you remove from a workflow an activity that has an error indicator and then re-add the
same activity in its place, the error indicator displays for the re-added activity. To clear
that error indicator, configure the activity correctly and run the workflow. [1035]

Unclear error message when a workflow cannot be deployed

If the remote runtime on which you are attempting to create a job does not have the
activity libraries used to create the workflow, a message starting with "The workflow failed
validation" appears. The message does not indicate that the workflow requires additional
activity libraries. You must install on a runtime any activity libraries used to create a
workflow. [777]

Cannot add security role assignments to built-in domain local groups

When you attempt to add a security role assignment to a local group that is in the domain's
Built-in CN, an error message appears. To work around this issue, you can create a group in
a different container, add the built-in group to the newly created group, and then add
security role assignments to the built-in group. [889]

Error message when attempting to modify the role store

An attempt to modify the role store from multiple computers can result in the error
message "Element not found". If this occurs, restart the AD Helper Service and restart
Workflow Studio. You should then be able to modify the role store. [908]

Limitations in workflow, activity, and global property names

The names of workflows, activities, and global properties cannot contain spaces or special
characters. This is a Microsoft limitation stemming from the use of those names in
namespaces. In addition, global property names cannot be the same as C# keywords, which
are reserved.

Creation dates shown in different formats when workflows sorted by date

When you sort the workflow projects table by the Created On column, the creation dates
displayed in the column and beside the Created On sort heading appear to differ. The
creation date displayed in the column is shown as the local time; the creation date
displayed in the sort heading is shown in GMT. [609]

Workflow Studio does not support InvokeWebServiceActivity

The InvokeWebServiceActivity currently cannot be used with Workflow Studio. If you need
to call web services, you must write a custom activity using the Workflow Studio SDK. [295]

Use of Promote Bindable Properties command can cause problems

Using the command Promote Bindable Properties can cause problems with your workflow
that will require you to delete and re-create the workflow.

Known Issues
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Right-click menu for Citrix If/Else activity contains an unsupported command

If you right-click the Citrix If/Else activity in a workflow, the menu includes the command
Add Branch. That command is not supported for the Citrix If/Else activity, which is a
reimplementation of the PowerShell If/Else activity to improve usability. If you need an
If/Else activity with more than two branches, use the PowerShell If/Else activity. (Note:
The Citrix If/Else activity is under Workflow Control in the Activities tab. The PowerShell
If/Else activity is hidden by default but can be added to the Activities tab by going to Tools
> Choose Activities and selecting the checkbox for the If/Else activity that has the
namespace System.Workflow.Activities.)

Get PageFile Info activity throws an exception under specific conditions

The Get PageFile Info activity does not run properly under Windows Vista and Windows 2008
if the Windows Virtual Memory setting is configured with the option "Automatically manage
paging file size for all drives" in the Advanced System properties. The activity runs
successfully if the Virtual Memory setting has a custom setting configured. Alternatively,
you can use the Virtual Memory option to automatically manage paging file size and include
a fault handler in your workflow to catch the exception thrown by the Get PageFile Info
activity. [852]

Start Workflow activity fails in one case

The Start Workflow activity fails if a parent workflow running on a runtime under Local
System tries to start a child workflow on a remote computer. To work around this issue, run
the parent workflow from a runtime that is not running under Local System. [779]

The Start Workflow Activity works in all other cases:

● When a parent workflow running under an Active Directory account tries to start a child
workflow on a remote computer (running under an Active Directory account or Local
System).

● When a parent workflow running under an Active Directory account or Local System
tries to start a child workflow on the same computer. Note that if the parent workflow
is running on a runtime under an Active Directory account and the child workflow is to
be started on a runtime under Local System, the Active Directory user must be granted
permissions on the runtime under Local System.

XenApp Profile Application activity throws an exception when linked to a specific
profile

You can bind the XenApp Profile Application activity to a specific profile by specifying the
"Linked Profiles Directory" and "Linked Profiles Names" parameters. Doing so results in an
exception and this error message: An error has occurred. The error is The process is already
in background processing mode. (Note that this is the same error you will receive if you try
to use the Streaming Profiler for the same task.) [1148]

XenApp Profile Application activity does not work on 64-bit platforms

Currently the Profiler SDK is available for 32-bit platforms only. [1086]

Serialization errors when using XenDesktop activities

When you run as a job a workflow that includes XenDesktop activities, you will receive a
serialization error when the job completes although the job does complete successfully.

Known Issues
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Workflows containing XenDesktop activities will fail if they include activities that trigger
persistence, such as the Delay activity. [1052]

XenDesktop activities cannot be used in Windows x64 environments

When you run a workflow that contains a XenDesktop activity, such as Connect To Farm,
the workflow fails and the Designer window Results pane contains this error: The term
'New-XdAdminConnection' is not recognized as a cmdlet, function, operable program, or
script file. This issue occurs because the XDCommands cmdlet is not registered to the
PowerShell snap-in. To install that cmdlet, open a PowerShell command prompt (as
administrator) and run installutil. Your paths might differ from the following example:

C:\Windows\Microsoft.NET\Framework\version\installutil.exe C:\Windows\assembly\GAC_MSIL\XdsCmdlets\version\XdsCmdlets.dll

[1062]

XenDesktop activities throw an exception on Windows 7

Several XenDesktop activities are known to throw an exception when a workflow is run on
Windows 7. The exception message begins with: Unable to cast COM object of type
'System.__ComObject' to interface type 'MetaFrameCOM.IMetaFrameFarm7'. [1091]

Issues Fixed in This Release
The following issues were fixed since the last release.

● Streaming Profiler should be installed before XenApp activity library is installed [1163]

● Incorrect error message supplied when an activity is bound to a "Get" activity that
returns no objects [1116]

● After a Workflow Studio Designer crash, you cannot add XenApp activities until you
clear the cache [1160]

● XenApp New Application activity parameter requirements vary based on selected
Application Type [1141]

● XenApp Profile Application activity does not support shared path for Profile Directory
[1164]

● XenApp Streaming Profiler cannot be installed if Streaming Profiler client is already
installed [1102]

● Wrong message displayed in installer if activity libraries are already installed [1125]

● Default Computer Name value for the Active Directory Create Computer activity is
invalid [1177]

Known Issues
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System Requirements

The Workflow Studio installer checks for the following required components. If a
component is not installed on your computer, the installer includes links for downloading
and installing the component.

● Correct Service Pack version of installed Operating System (see Supported Systems and
Products)

● Microsoft .NET Framework 3.5 SP1 or 4.0

● Windows PowerShell 2.0

● Authorization Manager (part of the Windows Server Administration Tools Pack)

● Microsoft SQL Server 2005 or 2008

Additional requirements for activity libraries:

● Microsoft .NET Framework 1.1: Includes the Group Policy Management Console, which is
required for the Citrix-provided Group Policy activity library.

● XenDesktop Desktop Delivery Controller SDK 4.0: Required for the Citrix XenDesktop
activity library.

● XenApp Streaming Profiler 5.2: Required for the Citrix XenApp activity library.

● Client machines where workflows with Hyper-V activities are run must be configured
with DNS servers. (The client machine must be able to convert the DNS name of the
Hyper-V server to its IP address.) Required for the Hyper-V activity library.

To create a role store in Active Directory, the domain functional level must be:

● Windows 2003 or higher
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Supported Systems and Products

The Workflow Studio administration interface is supported in English on the following
Windows x86- and x64-based English and non-English operating systems:

● Windows 7 (all editions)

● Windows Server 2003 (all editions)

● Windows Server 2008 (all editions except Core)

The Workflow Studio data store is supported on SQL Server 2005 or 2008 on the following
Windows x86- and x64-based English and non-English operating systems:

● Windows Server 2003 (all editions)

● Windows Server 2008 (all editions supported by SQL Server)

The workflow runtime is supported on the following Windows x86- and x64-based English
and non-English operating systems:

● Windows Server 2003 (all editions)

● Windows Server 2008 (all editions except Core)

Workflow Studio 2.5 is supported by and included with the following Citrix products:

● Citrix XenApp (Advanced, Enterprise, and Platinum editions)

● Citrix XenDesktop (VDI, Enterprise, and Platinum editions)

● Citrix NetScaler (Standard, Enterprise, and Platinum editions)

● Citrix XenServer (Advanced, Enterprise, and Platinum editions)

● Citrix Essentials for Hyper-V (Enterprise and Platinum editions)
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Installing and Configuring Workflow
Studio

Workflow Studio deployment options include a full install and a runtime-only install. A full
install includes a management interface, the Workflow Studio Designer, and optional
runtime(s). With a full install, you can develop and test workflows, schedule and review
jobs (instances of workflows that are scheduled to run or that are run on demand), and
manage runtime and workflow security. SQL Server is a required component of a full install.
SQL Server stores the workflows, job history (tracking), and job state (persistence). Active
Directory is required if you set up remote workflow deployment. In that scenario Active
Directory is where your security role stores and runtime connection points are stored. If you
are not deploying workflows to remote computers, you can alternatIvely configure
Workflow Studio to store those items locally in an XML file.

A Workflow Studio runtime is implemented as a Windows service. A runtime enables you to
execute workflows. You can have multiple servers in your deployment and each server can
have multiple runtimes. A workflow runs under the context of the account used for the
runtime service, enabling you to set up runtimes for different user accounts. A runtime
install does not require SQL Server but you can configure a runtime to connect to SQL
Server for central storage.

The following topics describe how to install, configure, and start Workflow Studio.

To install Workflow Studio Install Workflow Studio or a runtime

To configure Workflow Studio Configure Workflow Studio

To install activity libraries Install activity libraries

To add a workflow runtime Add a workflow runtime

To uninstall Workflow Studio or
activity libraries

Uninstall components

To start Workflow Studio Start Workflow Studio



29

To install Workflow Studio

Before you install, gather the following information:

● The server name or IP address of the server you will use to validate a license for
Workflow Studio.

● You will need the license server information if you use Essentials for Hyper-V,
XenApp, or XenDesktop to validate your license.

● If you use XenServer or NetScaler to validate your license, you must provide
credentials to log in to the XenServer or NetScaler device.

● The workflow database server name (and instance name if using SQL Express or a
named instance with SQL Server).

● If you want to create more than one workflow runtime on your computer, the
credentials you want to use for each workflow runtime service.

● If you plan to use Active Directory for the security role store, you will need credentials
to use for the Workflow Active Directory Helper Service. The account you use must have
rights to query the role store in Active Directory. (Active Directory is required for
multi-server deployments.)

● If you plan to use the XenApp activity library, you must install a workflow runtime on a
XenApp server at your site. It is recommended that you set up a XenApp server for this
purpose that is not publishing applications. You can then use IMA to communicate from
the XenApp server with the runtime to all the servers at your site.

● For third-party applications to be used in your workflows, determine whether you can
communicate with them remotely. If you cannot, a runtime must be installed on the
server hosting the third-party application. For example, Workflow Studio can connect to
Active Directory and Group Policy remotely, so there is no need to install a runtime on
a specific server. However, Windows activities that work with files and resources from
performance monitor, event log, and similar tools will need to have a runtime running
directly on the server hosting those resources.

Note: In Windows Server 2008, User Account Control (UAC) gives domain administrators
restricted access. As a result, to install Workflow Studio on Windows Server 2008 over a
Remote Desktop Session you either need to log in as a local administrator or use the
Windows 2008 Server "Install Application on Terminal Server" feature available from the
Windows Control Panel.

To install:

1. Verify that your computer has the required software listed in System Requirements.

2. Download the Workflow Studio ISO file from the Citrix Support site. The ISO contains
Setup.exe and the appropriate MSI files for your system:

http://www.citrix.com/wfs


● To install the full product: WFStudio.msi for x86 systems or WFStudio_x64.msi for
x64 systems.

● To install the workflow runtime only: WFSRuntime.msi for x86 systems or
WFSRuntime_x64.msi for x64 systems.

● To install activity libraries: WFStudioActivities.msi for x86 systems or
WFStudioActivities_x64.msi for x64 systems.

Some pre-requisite software is also available at that location. You can download it from
there or from the Microsoft support site. If the installer detects a missing component, it
provides a link that you can click to download or install the component.

3. Double-click Setup.exe to start the installer.

4. Click Run.

5. Click the component that you want to install:

● Full product

The Workflow Studio installers (WFStudio.msi and WFStudio_x64.msi) set up the
Workflow Studio interface and runtime.

● Runtime only

The runtime installers (WFSRuntime.msi and WFSRuntime_x64.msi) install only the
runtime. This is useful on computers that will run workflows but do not need access
to the Workflow Studio interface. The full product and runtime-only option cannot
be installed on the same computer.

● Activity Libraries

You must install Workflow Studio before you can install an activity library. You will
need to install activity libraries on development computers and on runtime servers.
For installation instructions for activity libraries, see To install activity libraries.

6. The Workflow Studio Component Setup dialog indicates if any of the prerequisite
software is not installed. Review the status messages for each component and follow
any instructions. When you are done, click Next.

7. In the Open File dialog, click Run.

8. Follow the instructions in the installation wizard:

a. In the Product Licensing Configuration dialog (displays only for full product
installation), select a Citrix product for which you have a license. After you click
Next, you will be prompted to log in to the server that validates your license. In
some cases, the server name or IP address must include the http:// or https://
prefix. Follow the on-screen instructions. The Citrix license server validates your
license if you choose any of the following Citrix products for licensing: Essentials for
Hyper-V, XenApp, or XenDesktop. If you choose XenServer or NetScaler to validate
your license, you must provide credentials to log in to the XenServer or NetScaler
device.

b. Specify an installation folder. The default installation folder is
%PROGRAMFILES%\Citrix\Workflow Studio.

To install Workflow Studio
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c. Click Install and then click Finish. The Workflow Studio Configuration wizard starts.

9. Follow the instructions on each page to complete the configuration. For additional
information, refer to To configure Workflow Studio.

10. When the Review Changes page appears:

a. Select each task to review the pending changes. If you need to make further
changes, click a page name in the navigation list. When you are done, click Review
Changes.

b. Click Apply.

c. After all changes succeed, click Close.

To install Workflow Studio
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To configure Workflow Studio

The Workflow Studio Configuration interface enables you to:

● Specify the workflow database connection information.

● Enable the Net.TCP Port Sharing Service (if you need Workflow Studio to communicate
with workflow runtime services on the local computer).

● Add/remove workflow runtimes.

● Configure the security role store.

● Configure a Windows Firewall port (if you need Workflow Studio to communicate with
runtime services on other computers).

To configure Workflow Studio:

1. The configuration wizard starts during installation. To change configuration settings,
run %PROGRAMFILES% > Citrix > Workflow Studio > Configure Workflow Studio.

2. Follow the instructions on each page to complete the configuration. You can navigate
to the pages in any order. For more information, refer to the following notes about the
pages.

Page Description

Workflow
Database

After you enter the Server and Database and click Connect, the
configuration tool displays buttons. Click the button that
corresponds to how you want your database handled. (The
Workflow Database page is not included when the Runtime Only
product is installed.)

TCP Port Sharing If you do not enable TCP Port Sharing, you cannot create
workflow runtimes.

Workflow
Runtimes

This page is available only if TCP port sharing is enabled.

You will see an entry for the workflow runtime already created
for your localhost. The workflow runtime service is named
WorkflowRuntimeHostService_domain_username.For example, if
your system name is PC2 and your user name is jsmith, the
service is named WorkflowRuntimeHostService_PC2_jsmith.

You can run multiple workflows from a single workflow runtime.
If you have a workflow that needs a different security context,
you can create another workflow runtime for it.



Security The best practice is to point all runtimes to the same role store
so that you can use the same security settings on all computers.

When you choose Active Directory, you configure two additional
pages: Role Store and Security Service. By default, a local cache
is configured for security role assignments (on the Security
Service page). As a result, when Workflow Studio needs security
role assigments, it obtains them from the local cache. Workflow
Studio refreshes the local cache from Active Directory according
to the Cache refresh interval.

Use a local cache for security role assigments if the performance
of the Active Directory connection is of concern. For example, if
Workflow Studio is installed in a branch office and the Active
Directory server is in another location, use a local cache to avoid
frequent communication with Active Directory.

Firewall As an alternate to changing your firewall setting, you can edit a
Workflow Studio configuration file to change the protocol and
port used for communications between Workflow Studio and
runtime services on other computers. Contact your Citrix support
representative for details.

3. After you complete your changes, click Review Changes.

4. On the Review Changes page:

a. Select each task to review the pending changes. If you need to make further
changes, click a page name in the navigation list. When you are done, click Review
Changes.

b. Click Apply.

c. After all changes succeed, click Close.

To configure Workflow Studio
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To install activity libraries

Activity libraries extend the functionality of Workflow Studio. The Workflow Studio
installation includes activities developed by Citrix that integrate products such as Citrix
XenApp, XenServer, and NetScaler as well as general purpose activities developed by
Microsoft and extended by Citrix.

You must install activity libraries on development computers where Workflow Studio is used
to create or test workflows. You must also install activity libraries on runtime servers where
workflows that reference the libraries are run.

If you use the XenApp activity library to create workflows that manage a XenApp farm, you
must install either the full Workflow Studio product or the runtime on one of the XenApp
servers in the farm. Workflows that use XenApp activities can only be run on a Workflow
Studio runtime that is installed on the XenApp server.

It is a good practice to check the Citrix Developer Network (CDN) website occasionally for
updates to the Citrix-supported activity libraries. You can also find information about the
activities on the Citrix Activity Library Reference.

CDN also includes custom activity libraries developed by the Workflow Studio community.
For information about installing them, see Customizing the Activities Tab.

To install activity libraries:

This procedure refers to files in the ISO image downloaded from the Citrix Support site, as
described in To install Workflow Studio: Setup.exe and WFStudioActivities.msi for x86
systems or WFStudioActivities_x64.msi for x64 systems.

1. Verify that Workflow Studio or the Workflow Studio runtime is installed on the
computer where you want to install activity libraries.

2. If you are upgrading the activity libraries from a previous release, uninstall the activity
libraries before proceeding. You can uninstall them by using the installer for the
previous release or by using the Windows Add or Remove Programs command.

3. Double-click Setup.exe to start the installer. The installer will check your system for
System Requirements.

4. Click Run.

5. Select Activity Libraries and click Next.

6. Follow the instructions in the Workflow Studio Component Setup dialog and then click
Next.

7. In the Open File dialog, click Run and then click Next.

8. Use the Custom Setup dialog to specify which activity libraries you want to install, click
Next, and click Install.

http://community.citrix.com/display/wf/Citrix+Activity+Library+Reference
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To add a workflow runtime

You can run multiple workflows from a single workflow runtime. If you have a workflow that
needs a different security context, you can create another workflow runtime for it.

1. Run %PROGRAMFILES% > Citrix > Workflow Studio > Configure Workflow Studio.

2. Click Next. The Workflow Runtime Installation dialog displays any Workflow Runtimes
already created for your localhost.

3. To create another runtime, click Add and enter credentials for the Workflow Runtime.
(Workflows run on that runtime will be executed using those credentials.) The Workflow
Runtime service is named WorkflowRuntimeHostService_domain_username. For
example, if your system name is PC2 and your user name is jsmith, the service is named
WorkflowRuntimeHostService_PC2_jsmith.
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To uninstall Workflow Studio or activity
libraries

The Workflow Studio installer checks for previous versions and allows you to uninstall a
previous version before proceeding with the installation. Uninstalling a previous version
does not remove the database or the security role store. Thus, your workflows, job history,
and security information are retained.

You can remove any of the components by using the Windows Add/Remove Programs
command. Note that you cannot uninstall activity libraries after you uninstall Workflow
Studio.

Alternatively, you can run the MSIs to uninstall the components, as follows:

● To uninstall activity libraries, run WFStudioActivities.msi for x86 systems or
WFStudioActivities_x64.msi for x64 systems. You cannot uninstall activity libraries after
you uninstall Workflow Studio.

● To uninstall Workflow Studio, run WFStudio.msi for x86 systems or WFStudio_x64.msi
for x64 systems.

● To uninstall a workflow runtime, run WFSRuntime.msi for x86 systems or
WFSRuntime_x64.msi for x64 systems.
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To start Workflow Studio

To log on to Workflow Studio, a Workflow Studio user must be an administrator on the
database for Workflow Studio.

1. Run %PROGRAMFILES% > Citrix > Workflow Studio > Workflow Studio.

2. When prompted, enter the database connection information. For Server, enter the
connection information that you specified during installation, in the form
server\databaseInstance. For example, if you entered localhost\SQLEXPRESS for the
Server name during installation, enter that for Server. If your SQL server is not using a
named instance, just enter the server.

For Workflow Studio database name enter WFDB (or the name that you specified during
installation).

3. Click Logon.

To start Workflow Studio from the command line
The Workflow Studio executable is WFS.exe. You can start Workflow Studio by passing the
server and database parameters to WFS.exe. For example:

%PROGRAMFILES%\Citrix\Workflow Studio\WFS.exe server localhost\SQLEXPRESS database
WFDB

If you omit either parameter from the command line, the log-in screen appears.
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Getting Started with Workflow Studio

After you install and configure Workflow Studio, follow the link below to begin a series of
guided exercises that introduce you to workflow management concepts and tasks. You will
learn how to:

● Start Workflow Studio.

● Navigate from the Workflow Studio administration interface to resources on the Citrix
Developer Network site and download a sample workflow.

● Import the downloaded workflow into your Workflow Studio database.

● Test the workflow from the Workflow Studio Designer window.

● Create and schedule a job that runs the workflow.

Click here to begin: Starting Workflow Studio
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Starting Workflow Studio

This topic assumes that Workflow Studio and the Citrix activity libraries are installed.

1. Run %PROGRAMFILES% > Citrix > Workflow Studio > Workflow Studio.

2. When prompted, enter the database connection information. For Server, enter the
connection information that you configured during installation, in the form
server\databaseInstance. For example, if you entered localhost\SQLEXPRESS for the
Server name during installation, enter that for Server. If your SQL server is not using a
named instance, just enter the server.

For Workflow Studio database name enter WFDB (or the name that you specified during
installation).

3. Click Logon. The Workflow Studio windows opens. It has three main areas:

● On the left is the navigation pane containing accordion tabs and an area where a
tree view of workflows, jobs, and security roles appears.

● In the center is an information pane containing details about workflows, jobs, and
security roles. For workflows and jobs, the upper portion of the information pane
contains a table view and the lower portion displays additional information about
the item selected in the workflows and jobs tables.

● On the right is the actions pane containing commands applicable to the current
selection.

4. To continue the tutorial, go to Importing the Sample Workflow.
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Importing the Sample Workflow

The procedures in this topic direct you to the Citrix Developer Network where you will
download a sample workflow and then import it into Workflow Studio.

Workflow import/export enables you to share workflows with other Workflow Studio users.

To download the sample workflow
1. In the Workflow Studio window navigation pane, click the Community tab. The

Workflow Studio page of the Citrix Developer Network opens in the information pane.

2. In the Community tree view, click Workflows. An RSS viewer appears in the information
pane, providing searchable access to all workflows posted on the Citrix Developer
Network. (The content is the same as if you had clicked the Workflows link on the web
page.)

3. In the Search box, start typing Export to filter the list.

4. Click the entry ExportServices Tutorial. A description of the workflow and a download
link appear.

5. Click the download link, click Save, and navigate to the location where you want to
save the workflow.

Note: Do not rename a workflow file. A workflow project includes several files with
internal references to the workflow name. If you rename a workflow, it will not run
successfully.



To import the sample workflow
1. In the Workflow Studio window navigation pane, click the Workflows tab.

2. Between the Workflows tree and the tabs, click the Create Category link and then
enter ServerMgmt. You will import the ExportServices workflow into this category.
Categories are used to organize workflows.

3. Make sure that ServerMgmt is selected in the Workflows tree.

4. In the Actions pane, click Import, navigate to ExportServices.zip (the file you
downloaded), and click Open.

The workflow appears in the projects table.

Notice that the workflow is assigned a version number when you import it. If you were
to import that same workflow again, it would appear in the projects table with the
same name, but a different version number.

5. To continue the tutorial, go to Testing the ExportServices Workflow.

Importing the Sample Workflow
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Testing the ExportServices Workflow

You can now run the workflow that you imported to test it. To do that, you open the
Workflow Studio Designer, a tool used to create, edit, and test workflows.

When you run a workflow from the designer, the first step is a temporary build process
which creates workflow assemblies on your computer. After the workflow completes
running, the temporary build files are removed from your computer (regardless of the
success or failure of the run).

The ExportServices workflow that you imported exports information about services on your
computer to two files: RunningServices.csv and StoppedServices.csv. When you test the
workflow, a dialog prompts for a path to those files.

To test the ExportServices workflow

1. In the projects table, right-click the workflow name, ExportServices, and then choose
Edit.

Alternatively, you could select ExportServices in the projects table and then click Edit
in the Actions pane.

After a slight delay, the workflow opens in the designer window.

2. To run the workflow, either click the Start button on the toolbar or choose Workflow >
Start.

3. When the Start Workflow dialog appears, notice that the export path is filled in. Change
the path if you like and then click Finish. After the workflow compiles, the message
“The build was successful” appears in the bottom pane of the window, the workflow
starts running, and additional messages appear as each activity is performed.

4. When the workflow completes, you can use your Windows browser to navigate to the
location of the .csv files.

5. You are now finished with the Workflow Studio Designer window. To close it, choose
File > Exit from the designer window.

6. To continue this tutorial, go to Creating and Scheduling a Job.
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Creating and Scheduling a Job

When you start a workflow from the Workflow Studio Designer window, it runs immediately
and interactively on your desktop. To run a compiled workflow according to a schedule, you
create a job for it. You also create a job when you want to deploy a workflow so it can be
available to other workflows.

A job consists of one or more workflows, a reference to a workflow runtime, a schedule
option, and any parameters required to run the workflow.

To create and schedule a job

1. Make sure that the ServerMgmt Workflow Projects table is still displayed in the
Workflow Studio window. If it is not, click the Workflows tab and then click
ServerMgmt in the Workflows tree.

2. Right-click the ExportServices workflow in the table and then choose Create Job. If no
server has been added to Workflow Studio, the message “There are currently no
registered servers.” appears. In that case, click the Jobs tab, click Add Server, and
enter localhost. Then, click the Workflows tab and repeat this step.

If you have multiple servers configured, you will be prompted to specify the server to
which you want to deploy the job. Enter localhost if prompted.

If your computer has more than one runtime running, you will be prompted to select a
runtime.

3. In the next screen, click Custom Schedule and then click Edit Schedule.

4. Configure the New Task Schedule dialog as follows:

a. From the Schedule Task drop-down menu, choose Once.

b. Specify a start time that is a few minutes later than the current time.

c. Click OK.
5. Click Next.

6. Because you are scheduling this job, Workflow Studio prompts you for the input needed
when the workflow runs, in this case a path for saving the export files. Enter a path
(ending with a backslash) and then click Finish.

7. To see your job, click the Jobs tab and then click your computer name in the Jobs tree.

8. View the Details pane at the bottom of the window. The Schedule tab in that pane
describes the schedule. The Job History tab lists major events (such as created,
started, completed, persisted) for jobs that have run. After you have created a job, you
can change its properties such as its schedule, the runtime to be used, or the
parameters required to run the workflow.



9. To change a the properties of a job: In the Jobs table, right-click ExportServices and
choose Properties. A Modify ExportServices Properties wizard appears. You can page
through that wizard if you like and change its properties.

Note: When you create a job, the same build process occurs as when you run the job,
the only difference being that the built assemblies are saved to Documents and
Settings\user\ My Documents on the computer where you initiated the job.

You have now completed the Workflow Studio tutorial.

Creating and Scheduling a Job
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Getting Started with Workflow Studio
Designer

After you install and configure Workflow Studio, follow the link below to begin a series of
guided exercises that cover tasks related to workflow creation. You will learn how to:

● Start Workflow Studio.

● Create a workflow category, create a workflow, and add activities.

● Use sequence and parallel activities.

● Configure activity properties using validation messages as a guide.

● Bind activities to properties using the interface as a guide.

● Create a global property and bind it to an activity.

● Test a workflow.

Click here to begin: About the Sample Workflow
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About the Sample Workflow

The workflow created in this tutorial obtains a list of services running on the local computer
and then exports two CSV files, one with a list of the running services and one with the
stopped services. When the workflow is deployed or is run in the Designer, the user is
prompted for the output path for the CSV files.

A workflow consists of activities that are connected in a logical and meaningful way. An
activity is an element of execution in a workflow. A little planning will help you organize
activities so that a workflow is easier to work with and contains sections that you can
expand and collapse.

The workflow in this tutorial includes the following activities:

● Get-Service: Gets a list of local services on a computer.

● Where-Object: Filters the objects (in this case, the services) that are passed to the
export file.

● Export to CSV: Exports the list of services to CSV files.

Note: For detailed information on activities and samples of their use, refer to the Citrix
Workflow Studio Developer Network.

The last two activities (Where-Object and Export to CSV) are used to export the running
services list and the stopped services list. You will group those activities by using a
ParallelActivity containing two SequenceActivities.

● A SequenceActivity is a composite activity that serves as a container for activities. A
SequenceActivity executes the contained activities in the order in which they appear.
You can collapse and expand the SequenceActivity container. You can also save a
SequenceActivity as a snippet for reuse.

● A ParallelActivity, a composite activity that enables you to connect activities in a
logical way, can also be expanded/collapsed and saved as a snippet.

Note: Parallel activities in Windows Workflow Foundation are not asynchronous. The
Parallel activity enables you to have multiple activities executing independent of one
another in a semi-parallel fashion at run time. Refer to Microsoft Windows Workflow
Foundation documentation for details on parallel activity processing.

When you have completed this tutorial, your workflow will look like this:

http://community.citrix.com/display/wf
http://community.citrix.com/display/wf


To continue the tutorial, go to Starting Workflow Studio Designer.
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Starting Workflow Studio Designer

This topic assumes that Workflow Studio and the Citrix activity libraries are installed.

1. Run %PROGRAMFILES% > Citrix > Workflow Studio > Workflow Studio.

2. When prompted, enter the database connection information. For Server, enter the
connection information that you configured during installation, in the form
server\databaseInstance. For example, if you entered localhost\SQLEXPRESS for the
Server name during installation, enter that for Server. If your SQL server is not using a
named instance, just enter the server.

For Workflow Studio database name enter WFDB (or the name that you specified during
installation).

3. Click Logon. The Workflow Studio windows opens. It has three main areas:

● On the left is the navigation pane containing accordion tabs and an area where a
tree view of workflows, jobs, and security roles appears.

● In the center is an information pane containing details about workflows, jobs, and
security roles. For workflows and jobs, the upper portion of the information pane
contains a table view and the lower portion displays additional information about
the item selected in the workflows and jobs tables.

● On the right is the actions pane containing commands applicable to the current
selection.

4. To continue the tutorial, go to Creating a Category and Workflow.
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Creating a Category and Workflow

Workflow Studio enables you to organize workflows by grouping them into arbitrary
containers called categories. For example, you might create a category named
"LoadBalancing" to contain workflows related to managing load balancing or a category
named "VM" to contain workflows related to managing VMs.

The Workflow Studio navigation pane shows a tree view of workflow categories. The top
node, Workflows, must contain at least one category before you can create a workflow.

To create a category and workflow

1. Click the Workflows tab, select the Workflows node in the tree, click the Create
Category link just above the tabs, and enter ServerMgmt.

2. Click ServerMgmt in the tree.

3. In the Actions pane click Create Workflow.

4. In the Create New Workflow dialog, type MyWorkflow and then click OK. The Designer
window opens. It contains the following areas:

● The Activities tab, on the left side of the Designer window, contains a tree view of
the installed activity libraries. Each activity library adds one or more activities to
the Activity tab. You drag and drop activities from the Activities tab to the design
surface to create workflows.

By default, very few of the available activities display in the Activities tab. Later in
this tutorial you will learn how to show the many other activities, including those
provided with PowerShell and activities created by Citrix.

● A description of the selected activity appears below the Activities tab.

● The design surface, in the middle of the Designer window, displays a visual
representation of a workflow. The design surface is where you drag and drop
activities to create a new workflow. You arrange the activities in the order you
want them to execute. You can rearrange activities by dragging an activity to a
different location in the workflow.

●

The results pane, which is below the design surface, displays informational
messages (), compiler errors (), and compiler warnings(). A workflow with

compiler errors will not build successfully. A workflow with compiler warnings
might build successfully but likely will not run correctly.

● The properties pane, on the right side of the Designer window, contains the
properties of the activity selected on the design surface. An activity property is a
configuration option that modifies the behavior of an activity. There may be zero or
more properties exposed by an activity.

● A description of the selected property appears below the properties pane.



5. To continue the tutorial, go to Adding Activities to a Workflow.
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Adding Activities to a Workflow

For background information on the activities used for this tutorial, see About the Sample
Workflow.

1. You can start the workflow by dragging the main containers it will include (a
SequenceActivity and a ParallelActivity) to the design surface. In the Activities tab,
expand the Workflow Control tree. All of the activities listed under Workflow Control
are developed by Citrix.

2.

From the Workflow Control list, drag SequenceActivity to the design surface and drop
it over the Drop Activities Here label.



3.

Drag ParallelActivity from the Activities tab to the design surface. Drop the
ParallelActivity on the arrow below the SequenceActivity container.

Note: While it is possible to nest the parallel activity inside the sequence activity, it
is best to keep them separate for a cleaner visual appearance and to simplify error
handling.

4. Next you will add an activity inside the sequenceActivity1 container: In the Activities
tab, expand Windows PowerShell and drag Get-Service inside the sequenceActivity1
container (dropping it over the label Drop Activities Here).

Note: The activities listed under Windows PowerShell are PowerShell cmdlets. Refer
to Windows PowerShell documentation for information.

5. Notice the default properties for the Get-Service activity in the properties pane. For
this activity, you will not change those defaults. Now you will add four activities to the
parallelActivity1 container.

6. Drag the Where-Object activity from the Windows PowerShell activities list to the 
design surface and drop it over the Drop Activities Here label in the sequenceActivity2

Adding Activities to a Workflow
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container.

7. Drag another Where-Object activity and drop it in the sequenceActivity3 container.

8. Drag the Export to CSV activity from the Windows PowerShell activities list and drop it
over the arrow that is below a whereObject activity.

9. To add the Export to CSV activity to the other sequence activity you will use a different
technique: Select the sequenceActivity3 container (just click in the white space inside
the container) and then double-click the Export to CSV activity (in the Windows
PowerShell activities list). The activity is added to the bottom of the container.

The following image shows the current view of the workflow.

Note: At any point if you need to quit this tutorial and resume later, save
MyWorkflow by going to File > Save Workflow. You can reopen the workflow by
selecting it in the Workflow Projects table and clicking Edit in the Actions pane.

10. To continue the tutorial, go to Renaming Activities.
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Renaming Activities

All activities are given a default name. You will next rename the activities so that their
names indicate their purpose in this particular workflow.

1. To give the first sequence activity a meaningful name, click sequenceActivity1 in the
workflow to select it, in the properties pane type getServices for Name, and press
Enter.

Note: Rather than pressing Enter, you can press Tab or just click in the window.

2. You have completed the getServices sequence activity. Collapse it by clicking the minus
icon beside getServices on the design surface.

3. Rename the four activities you just added as follows: On the design surface, click the
activity to be renamed and then in the properties pane type the new name beside the
(Name) label. Use the following names for the activities:

whereObject = whereObjectRunning

exportToCSV = exportRunningToCSV

whereObject1 = whereObjectStopped

exportToCSV1 = exportStoppedToCSV

The workflow should match the following image.



4. Click parallelActivity1 to select it and then, in the properties pane, change its name to
exportToCSV. The more descriptive name will be handy if you later decide to save
this parallel activity as a snippet.

5. To continue the tutorial, go to Creating a Global Property.

Renaming Activities
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Creating a Global Property

The workflow that you are creating will generate two output files. To enable an
administrator to specify the destination of the output files, you will create a global
property for the export path. When creating a job to run this workflow, the administrator
can enter a value for the export path so that the workflow can run unattended.

In this exercise you will create a global property for the export path. Later you will bind the
global property to the Folder Path property of the two exportToCSV activities.

1. In the Workflow Studio Designer window menu bar, choose Workflow > Manage Global
Properties and click Add. The Add Global Property dialog box opens.

2. For Name, enter ExportPath. This name will help you locate the global property when
you are ready to bind to it. For this exercise, it is not necessary to enter a Display Name
or Description. (If a Display Name is entered, it appears in the Start Workflow dialog,
the Create Job wizard, and the Job Inspection window instead of the Name.)

3. From Type, choose String. Dialog box settings change to reflect the data type selected.

4. For Default Value, enter C:\. This is the value that will appear when the person
deploying or running the workflow is prompted to enter the export path.

5. Verify that the checkbox for Prompt for value during deployment if scheduling option
is Start or Custom Schedule is selected. As a result of selecting the checkbox, the
person deploying the workflow will be prompted for the value (in the Create Job
wizard). You would not select this checkbox if you had a another workflow or some
other process that supplied the value to the workflow.

6. Click OK twice.

7. To continue the tutorial, go to Configuring Activity Properties.
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Configuring Activity Properties

Notice the validation flag () above the top right corner of the whereObjectRunning
activity. The validation flag indicates that the activity does not have enough data

defined for it to pass validation and thus would prevent the workflow from executing. To
define the data, you configure properties for the activity.

1. Mouse over the validation flag of the whereObjectRunning activity. When the flag
appears inside of a gray box, click in that box to see the validation messages. Notice
that validation flags also appear in the properties pane beside the corresponding
parameters.

2. Click to select the first validation message. The corresponding property is highlighted in
the properties pane and the insertion point is placed in the value field for that
property.

3. Click the binding drop-down icon for the Input parameter.

The binding list shows all activities that precede the activity in the workflow, along
with their properties. The list also includes any global properties. The list scrolls to

the previous activity, which is often the most likely activity used for binding. The icon
indicates that a property is an output property and therefore the most likely choice for
binding.

4. In the binding drop-down menu under getService, choose Output to bind the
Where-Object activity to the output of the getServices activity. The Where-Object
activity will filter the objects returned by the getServices activity. The binding string
for the Input parameter displays as: Activity=getService, Path=Output.

5. Click the validation flag for whereObjectRunning. Notice that the message you selected
before has been removed. Select the remaining validation message. In the properties
pane, Filter Script is now highlighted.

6.

Click the Filter Script row in the properties pane. Notice the and the icons.

The icon represents a dialog box and the icon signifies that the property is bindable.
Workflow Studio Designer uses the property type to determine whether to present the
binding drop-down list, the Edit Property dialog box, or some other dialog box
appropriate for the data type. The default editor for strings is the Edit Property dialog
box, where you can create a custom string if needed.

7. Click the icon and enter the following PowerShell command in the Edit Properties
dialog box. This command limits the objects returned to those with a Status equal

to “Running”:
$_.Status -eq "Running"

In case you are not familiar with PowerShell variables: “$_” refers to the current pipeline
object. The dot notation ($_.Status) refers to the Status property of the current pipeline
object.



8. Click OK. The validation flag disappears, indicating that the activity has the minimal
information to build. However, the activity might need additional configuration to
execute properly. You should always review the activity properties to ensure that the
default settings are what you intend.

9. Repeat steps 1 through 8 for whereObjectStopped, using this Filter Script:

$_.Status -eq "Stopped"

10. Click OK.

When you are finished, the properties pane for whereObjectStopped should match the
following image.

11. To continue the tutorial, go to Binding to a Global Property.
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Binding to a Global Property

The workflow still has validation flags that need to be cleared before you can successfully
run the workflow. In the following steps you will create a binding so that the services lists
are passed to the CSV files. You will also bind to the ExportPath global property to specify
the default path for the two CSV files output by the workflow.

To specify the parameters for the two Export to CSV activities

1. Click the validation flag for exportRunningToCSV and select the first validation
message.

2. In the properties pane, double-click then Switch Editor icon for the Folder Path
property and then click the binding drop-down icon on the Folder Path row.

3. In the binding menu under the Global Properties heading, select ExportPath. The Folder
Path should now be set to the following:

Activity=MyWorkflow, Path=ExportPath

4. In the properties pane, enter the following file name for the File Name property:

RunningServices.csv

5. Notice that there is still a validation flag for exportRunningToCSV. Click the validation
flag for exportRunningToCSV and select the validation message.

6. In the properties pane, click the binding drop-down icon on the Input row. Under
whereObjectRunning, choose Output.

That setting binds the input of exportRunningToCSV to the output of
whereObjectRunning.

The validation flag for exportRunningToCSV is now removed.

Before moving on, there is one more property to set for the exportRunningToCSV
activity.

7. In the properties pane, click the Overwrite row and then choose True from the binding
list.

That setting causes the output file to be overwritten each time the workflow is run.
The parameter values for exportRunningToCSV should match the following image.



8. Repeat steps 1 through 7 for exportStoppedToCSV. In summary:

a. Select the exportStoppedToCSV activity, click the binding drop-down icon for the
Folder Path property, and choose the ExportPath global property.

b. Enter the following file name for the File Name property: StoppedServices.csv.

c. Click the binding drop-down icon on the Input row. Under whereObjectStopped,
choose Output.

d. Click the Overwrite row and then choose True from the binding list.
When you are finished, the properties pane for exportStoppedToCSV should match the
following image.

9. As you work on a workflow, you are working with it on disk. To save the workflow to the 
database, click Save in the toolbar. The message "The build was successful" appears in
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the results pane. If it does not, review your workflow against the tutorial steps to fix
any errors.

10. To continue the tutorial, go to Testing the Workflow.
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Testing the Workflow

To test a workflow you run it from the Workflow Studio Designer window where it executes
immediately and interactively on your desktop. Thus, you can easily alternate between
testing the workflow and editing it from the same window.

Note: When you want to run a compiled workflow according to a schedule, you create a
job for it. You also create a job when you want to deploy a workflow so it can be called
from other workflows through the Start Workflow activity. After you deploy a workflow,
any edits to it are saved to another workflow with the same name but a different version
number.

1. Click Start in the toolbar.

2. When prompted, enter a path for the export files and then click OK.

Note: When you create a job for a workflow, you specify for the job any parameters
required to run the workflow, thus enabling the workflow to run unattended.

Status messages appear in the results pane. The two CSV files created by the workflow
are saved in the output path you entered.

You have now completed the Workflow Studio Designer tutorial.
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Creating and Managing Jobs

The following topics describe how to manage workflow projects and to create, schedule,
and manage jobs.

To create a workflow category Create categories to contain related workflows

To manage categories Move a workflow between categories; delete a
workflow or category

To view and filter workflow
projects

Change your view of workflow projects

To import a workflow Import a workflow

To export a workflow Export a workflow to share it with others

To test a workflow Test a workflow in Workflow Studio Designer

To specify a server for running
jobs

Add the servers to which you will deploy jobs

To create a job Create a job to deploy and/or schedule a workflow

To view job details and event
history

View jobs and their history

To view workflow details for a
job instance

View workflow details in the Job Inspection window

To manage jobs Enable/disable jobs, change your view of the jobs
table, delete a job, and view deleted jobs

To change job properties Change a job's schedule, runtime, or parameters

To clear job history for a
runtime

Remove all job history for a runtime
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To create a workflow category

You must create at least one workflow category before you can create or import a
workflow. You can organize workflows by creating nested categories.

1. Click the Workflows tab.

2. In the Workflows pane, click the folder to contain the category and then click the
Create Category link below the folder list. Alternatively, in the Workflows pane
right-click the folder to contain the category, select Create Category, and then type a
descriptive name for the category.

3. A workflow category, by default, has security permissions set to Full Control for the
Everyone group. For help with changing security permissions on a category, see Securing
Workflow Categories and Jobs.
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To manage categories

Use these tasks to clean up and organize your workflow categories.

To move a workflow to a different category
1. Click the Workflows tab and then click the current category of the workflow.

2. Drag the workflow name from the workflow table and drop it in a category folder.

To delete a category
1. Click the Workflows tab and then click the category.

2. Delete the contents of the category, including workflows and nested categories:
Right-click the category name in the workflow tree and then choose Delete from the
menu.

To delete a workflow
1. Click the Workflows tab.

2. In the Workflow Projects table, right-click the workflow name and choose Delete. A
workflow that is deployed as a job cannot be deleted. You must delete all jobs created
from the workflow and then delete the workflow.
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To view and filter workflow projects

From the Workflows tab you can view a table containing information for all workflow
projects included in a particular category. You can filter, sort, and group the workflow
projects table to change your view of it.

To view workflow projects
1. Click the Workflows tab.

2. In the Workflows tree view, select a workflow category name. Alternatively,
double-click a workflow category name in the Workflow Items table.

To filter the workflow projects table
● To filter the table by workflow name: In the Search Workflows box, type the first few

characters of the names you want to view. To view all workflows again, clear the
Search Workflows box.

● To filter the table by a column heading: Mouse over a column heading, click the down
arrow that appears, and click an item in the menu. To clear the filter, choose Clear
Filter from the menu.

To sort the workflow projects table
● To sort the table by column: Click a table column header.

To group the workflow projects table
● To group the table by column: Drag a column header to the space above the column

headers.

● To nest the groupings, drag additional column headers to the group area. Hint: If you
have multiple versions of a workflow, group the projects table by Name and then sort
the table by version.

● To rearrange the groupings, drag the column header boxes inside the group area.

● To remove the grouping, drag the column header boxes back into the table area.
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To import a workflow

Workflow import and export enables you to share workflows with other users and instances
of Workflow Studio on other computers. When you Import a workflow, Workflow Studio
unpackages the files and puts them in its database.

1. Verify that the file you plan to import has an extension of .wfsp and not .zip. If the file
is zipped, unzip the file before proceeding.

2. Click the Workflows tab.

3. Click a workflow category name in the Workflows tree.

4. In the Actions pane, click Import. Alternatively, right-click in the workflow projects
table and choose Import from the menu.

5. Navigate to the workflow project (.wfsp file) and click Open. The workflow appears in
the Workflow Projects table.

You cannot rename a workflow. Several files comprise a workflow and include
references to the workflow name. Therefore, if you rename a workflow file, it will not
run.
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To export a workflow

Workflow import and export enables you to share workflows with other users and instances
of Workflow Studio on other computers. When you export a workflow, Workflow Studio
packages the workflow files into a single cab file and copies that file to a specified
location.

1. Click the Workflows tab.

2. Click a workflow category name in the Workflows tree.

3. In the Actions pane, click Export.

4. Specify an export location and then click Save.

The workflow project is saved as a .zip file.

You can share the workflow with other users who must unzip the file before importing
the workflow.
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To test a workflow

Before you deploy a workflow you should run it from the Workflow Studio Designer to verify
that it works as you intended. Workflows started from the designer run under the currently
logged-in user context only.

When you run a workflow from the designer, the first step is a temporary build process
which creates workflow assemblies on your computer. After the workflow completes
running, the temporary build files are removed from your computer (regardless of the
success or failure of the run).

1. Click the Workflows tab.

2. Click a workflow category name in the Workflows tree.

3. Right-click a workflow name in the Workflow Projects table and choose Edit. The
workflow opens in the designer window.

4. In the Workflow Studio Designer window toolbar, click the Start button. After the
workflow compiles, the message “The build was successful” appears in the bottom pane
of the window, the workflow starts running, and additional messages appear as each
activity is performed.
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To specify a server for running jobs

To deploy a job to a server (either your localhost or a remote server), the server must meet
these requirements:

● The server must have either the full Workflow Studio product or at least one Workflow
Studio runtime installed.

● The server must have any activity libraries installed that are used on the development
computers.

● If a workflow was signed with a certificate (to encrypt included passwords), the
workflow runtime on the server must have the same security certificate used to sign the
workflow project.

● The server must be added to the Workflow Studio interface from which you are creating
or deploying the job.

Click either the Jobs or Runtime Security tab, click Add Server, and then enter the server
name or IP address. For example, you might specify localhost. The server that you add must
already have a Workflow Studio runtime installed. (The Add Server link does not appear if
you have configured Workflow Studio to store roles in XML.)
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To create a job

A wizard leads you through the steps of creating a job. A job references a workflow, a
runtime, a schedule option, and any parameters required to run the workflow. You can also
use the wizard to deploy (but not schedule or run) a workflow.

It is recommended that you test a workflow before creating a job for it. Testing a workflow
enables you verify that the workflow compiles successfully and that the parameters you
specify for the job will work as expected when the job is deployed.

1. Click the Workflows tab.

2. In the Workflows tree, click a workflow category name.

3. In the Workflow Projects table, click a workflow name.

4. In the Actions pane, click Create Job.

If you have added more than one runtime to Workflow Studio, you will be prompted to
select a runtime. If you have just one runtime, the dialog that prompts for the runtime
is skipped.

If you do not see the runtime you want to use for the job, cancel the wizard and add
the runtime, as described in To add a workflow runtime.

5. Choose a schedule type:

● No Schedule (Deploy Only)

This setting is used to deploy a workflow that will be called by other workflows or
by an external interface that starts the workflow. (A workflow cannot be executed
if it is not deployed.) When you use this schedule type, the job creation wizard
does not prompt for parameters and the workflow is copied to the runtime but is
not run. Any parameters needed to run the workflow should be specified with the
Start-Workflow activity or through the external interface. A job with this schedule
type will have a status of Deployed in the Jobs tab and will not be executed except
when it is called by another job.

● Run Immediately

This setting is used to deploy a workflow and execute it one time. When you use
this schedule type, the job creation wizard prompts for configuration parameters (if
the workflow includes any) for the one execution. A job with this schedule type will
have a status of Deployed in the Jobs tab; to run the deployed job again, you run it
on demand.

● Custom Schedule

This setting is used to deploy a workflow and configure a task schedule in the 
Windows Task Scheduler. When you use this schedule type, the job creation wizard



prompts for configuration parameters (if the workflow includes any) to be used for
each scheduled execution. A job with this schedule type will have a status of
Scheduled in the Jobs tab. You schedule the job by clicking the Edit Schedule
button. If you choose Custom Schedule but do not schedule the job, the job will be
configured as if you had chosen the No Schedule option.

Note: By default, users have access to all of the schedule types. Your Workflow
Studio administrator might limit access by changing the default security role settings.

6. To configure a schedule in the New Task Schedule dialog, specify the following:

a. In the Schedule tab:

● In Schedule Task, enter a frequency or condition for running the job.

● In Start Time, enter the first time that you want the job to run.

● Based on your selection from Schedule Task, other options to refine the
schedule might appear.

● To set more than one schedule for the job, click Show multiple schedules.

● To specify start/end dates for the job or to configure a repeat frequency for
the job, click Advanced.

b. In the Settings tab, enter options as needed for deleting and stopping the job, as
well as handling the job based on power management conditions.

7. Click Next.

8. If the workflow being scheduled has global properties (with the “This property is a
workflow parameter” option set), the wizard displays the parameters so you can
configure them.

9. Click Finish.

To create a job
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To view job details and event history

A job has one of the following statuses:

● Deployed

Creating a job with either the No Schedule or Run Immediately option results in the job
being deployed. Such jobs have a status of Deployed in the jobs table. To determine
which of the two options was used to create a job, check the Job History tab to see if
the job ran once.

● Scheduled

Creating a job with a Custom Schedule results in the job being deployed (if it is not
already deployed) and scheduled. Such jobs have a status of Scheduled in the jobs table
and the schedule appears in the Schedule tab. Each time a job runs, a row is added to
the Job History tab.

● Disabled

If a job is scheduled, you can disable it, which changes its status in the jobs table to
Disabled. If you enable a disabled job, its status changes back to Scheduled (even if the
schedule has expired).

● Deleted

Deleting a job changes its status to deleted and removes it from the jobs table (by
default). However, job history is retained and can be viewed (through Show Deleted
Jobs).

The status of a job determines the properties you can change and the effect of those
changes, as described in To change job properties.

● To view a list of jobs, click the Jobs tab and then select a runtime name in the Jobs
tree.

● To view schedule details for a particular job, click the job name in the jobs table and
then click the Schedule tab in the Details pane.

● To view the event history of a job, click the job name in the jobs table and then click
the Job History tab in the details table. The Job History tab contains a row for each
time a job is created, started, completed, and persisted.

● To update the job information, click Refresh in the Actions pane.
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To view workflow details for a job instance

The Job Inspection window provides detailed information for all job instances, including
tracking data for running workflows and information that helps you troubleshoot jobs that
do not run successfully. In the Job Inspection window you can view the workflow without
needing to open the Workflow Studio Designer.

1. Click the Jobs tab and then select a runtime name in the Jobs tree.

2. Right-click the job name in the jobs table and choose Open. The Job Inspection window
opens.

3. In the Job Inspection window, select a job instance to view the workflow and workflow
details such as the fully-qualified workflow name, the workflow runtime, and any
workflow parameters.

● To toggle the details, click the arrow to the left of “Details”.

● To troubleshoot a workflow, click an activity that has a red icon on the upper right
corner of the activity bubble. Doing so highlights the corresponding activity
messages.

● To stop, pause, and resume a running job, choose a command from the Workflow
menu or click the corresponding icon in the window’s toolbar.

● To open Workflow Studio Designer from the Job Inspection window, choose
Workflow > Open.
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To change job properties

After you create a job, you can change its schedule, the runtime to be used, and the
parameters required to run the job.

1. Click the Jobs tab and then select a runtime name in the Jobs tree.

2. In the Jobs table, right-click the job name and choose Properties. The Modify
Properties wizard appears. The screens in the wizard are just like those in the Create
Job wizard. The status of a job determines the properties you can change and the
effect of those changes, as follows:

● For deployed jobs:

● Choose Run Immediately to run the job once with a specified set of
parameters. The parameters default to the last set used to run the job.

● Choose Custom Schedule to run the job according to a schedule.
● For scheduled jobs:

● Choose Run Immediately to run the job once right now. The job also continues
to run according to its schedule. If the job has parameters, any changes you
make for the immediate run are also used for future scheduled runs.

● Choose Custom Schedule to change the parameters or schedule for future
scheduled runs.

● Choose No Schedule to remove the schedule from the job.
● For disabled jobs:

● Changing the properties of disabled jobs has the same results as for scheduled
jobs, with one exception: When you finish editing the properties, the job
remains disabled. Thus, you can run a job immediately even if it has a status of
disabled.

● For deleted jobs:

● You cannot change the properties of a deleted job.
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To manage jobs

From the Jobs tab you can view a table containing information for all jobs deployed to a
particular runtime. You can filter, sort, and group the jobs table to change your view of it.
You can enable/disable jobs, delete jobs, and view deleted jobs.

To disable/enable a job
1. Click the Jobs tab and then select a runtime name in the Jobs tree.

2. To disable a scheduled job, right-click the job name in the jobs table and choose
Disable. To enable a disabled job, right-click the job name (must have a status of
Disabled) in the jobs table and choose Enable.

To filter, sort, and group the jobs table
● You can filter, sort, and group the a jobs table using the same methods as for working

with a workflow projects table, as described in To view and filter workflow projects.

● If create more than one job from a workflow (perhaps to deploy it to different
runtimes), the job name in the jobs table will be the same for each job. in that case,
grouping the jobs table by the Runtime column will make it easier to read the table.

To delete a job
1. Click the Jobs tab and then select a runtime name in the Jobs tree.

2. Right-click the job name in the jobs table and choose Delete.

To view deleted jobs
1. Click the Jobs tab and then select a runtime name in the Jobs tree.

2. In the Actions pane, click Show Deleted Jobs.
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To clear job history for a runtime

Deleting a job changes its status but does not remove its history. You can remove all job
history for a runtime by deleting the runtime and then re-adding the runtime with the same
credentials.

1. From the Windows Start menu, choose All Programs > Citrix > Workflow Studio >
Configure Workflow Studio.

2. When the Workflow Database Configuration screen appears, click Next.

3. In the Workflow Runtime Installation screen, click the runtime to be deleted and click
Remove.

4. Click Add, enter the credentials for the runtime service, andl then click OK.

5. Click Next twice and then click Finish.
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Creating and Editing Workflows

The following topics describe how to use the Workflow Studio Designer to create, edit, and
test workflows:

Planning and Starting a
Workflow

Plan and begin creating a workflow.

Editing and Deleting Workflows Access a list of workflow projects from which you can
delete a workflow or open the Workflow Studio
Designer to edit a workflow

Changing Your View of the
Designer Window

Close and open panes, change the view of the design
surface, view a workflow as an outline, change the
order in which properties appear, switch between
property editors, view cancel and fault handlers, and
view workflow code and project files

Customizing the Activities Tab Add installed activities to the Activities tab, install an
activity library which does not have an installer, add
an activity from the GAC, and search for an activity in
the Activities tab by name

Adding Activities to a Workflow Add activities to the design surface, review items to
verify after adding an activity, review notes related to
using parallel and sequence activities

Adding a Branch to a Parallel
Activity

Add a branch to a parallel activity and reorder parallel
activity branches

Creating a Global Property Create a global property that can be used in muliple
activities

Binding Activity Properties Read about the concept of activity binding and how
Workflow Studio handles binding

Starting a Workflow from
Another Workflow

Use the Start-Workflow activity to start another
workflow from the current one

Creating and Working with
Snippets

Save an activity as a snippet, add a snippet to a
workflow, and delete, share, and import snippets

Creating an Activity without
Writing Code

Expand the activity library by creating an activity
based on another activity such as PowerShell Script,
Windows Script, Command Script, and SNMP activities.

Using the Delay Activity to
Persist a Workflow

Add a persistence checkpoint to a workflow.

Adding Custom Code to a
Workflow

Edit the automatically generated source code (the
code-beside file)

Adding a Missing Component Add a reference to a missing component

Securing Workflows that
Contain Password Values

Read about the supported encryption methods, obtain
and install certificates, choose a certificate for a
workflow, and view the certificate associated with a
workflow



Working with Fault Handlers Read about the Stop On Error property included for
each activity and workflow, add a fault handler to an
activity

Customize
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Planning and Starting a Workflow

Before you start creating a workflow, taking the time to plan the workflow will make the
creation process more efficient.

1. Create a flowchart of the process that you plan to automate. Be sure to capture all
processing steps in the sequence in which they are to occur. If the flowchart becomes
complex, consider breaking the complex process into smaller ones.

2. On your flowchart, indicate the activities that map to each step in the process.

3. Determine the input data required for the workflow.

4. In Workflow Studio Designer open a new workflow and add a global property for each
input data item identified in the previous step.

5. Add the activities that you identified for each processing step. Be sure to rename
activities, as needed, to indicate their purpose in the workflow.

6. Configure the parameters for each activity.
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Editing and Deleting Workflows

To edit or delete a workflow
1. Click the Workflows tab and then click a workflow category name in the Workflows

tree.

2. Click a workflow name in the Workflow Projects table and then click Edit or Delete in
the Actions pane.

The commands listed in the Actions pane are also available by right-clicking in a
workflow table. For commands that operate on a particular workflow, be sure to
right-click the workflow name. For other commands, you can right-click anywhere in
the table.

3. Use the Workflow Studio Designer window to edit a workflow.
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Changing Your View of the Designer
Window

The following topics describe how to change the designer window to optimize your view of
a workflow and its properties, handlers, and associated code.

To close and open panes
You can quickly resize the design surface by closing or opening surrounding panes. When
working in the Designer window, you generally should have all three panes visible. If a
command does not appear to work, make sure there are no hidden panes.

From the View menu choose any of the following:

● Left Pane: Toggles the pane containing the Activities tab.

● Bottom Pane: Toggles the results pane.

● Right Pane: Toggles the properties pane.

To change the view of the design surface
When a workflow grows larger than the design surface, zoom and navigation features make
editing and reviewing the workflow easier. You can also view an outline of a workflow so
you can quickly scroll the design surface to a different portion of the workflow.

The icons in the following procedures are located under the vertical scroll bar for the
design surface.

● To preview how a workflow will print, click the icon and choose Print Preview. 
Use File > Print Setup to change the margins and other page settings. When you

are done, return to the normal view: Click the icon and choose Default View.
● To set a zoom level, click the icon and choose an option.

● To determine the action that occurs when you click the design surface, click the
icon and choose one of the following tools:

● Zoom In: Enlarges the design surface each time you click it, centering the workflow
on the point that you click.

● Zoom Out: Reduces the design surface each time you click it.

● Navigation Tool: When a workflow is larger than the pane, the navigation tool
enables you to grab the workflow and change its position in the pane.

● Default: Selects items in a workflow. When a workflow is larger than the
pane, clicking the fit icon (bottom right corner of the design surface) zooms
out the workflow so that it fits the pane. Click that icon again to return to



the default 100% view.

To view the workflow as an outline
● From the View menu choose Outline. Click an activity in the outline to select it on the

design surface.

To change the order in which properties appear
By default, properties are shown categorized by headings such as Activities, Parameters,
and Read-only Output. You can also view them alphabetically.

● At the top of the properties pane, click the icon to view properties alphabetically
or the icon to view properties categorized.

Note: Most activities have at least one output property which is listed under the
“Read-only Output” category. Output properties can contain data that other activities in
the workflow access. These properties are all read-only because they are not intended to
be modified, but rather used by the activity itself at run time.

To switch between property editors
For each property displayed in the Properties pane, Workflow Studio Designer uses the
property type to determine whether to display by default the binding drop-down list or

a dialog box appropriate for the data type. A binding list shows all activities that precede
the activity in the workflow, along with their properties. The list scrolls to the previous
activity, which is often the most likely activity used for binding and includes the icon beside
the output property.

In the following screen samples, the default editor for the Input Required parameter is a
drop-down list and the default editor for the Target Property parameter is a dialog box.

Sample of drop-down list as default editor

Sample of dialog box as default editor

Changing Your View of the Designer Window
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To choose a different property editor:
●

Double-click the Switch Editor icon to choose the alternate editor. The Switch Editor
icon then changes to .

● Double-click the icon switch back to the default editor.

Tip: If you are familiar with the Microsoft Bind dialog and would prefer to use it
instead of the dialog box provided with Workflow Studio, access it by

double-clicking the icon. The Edit Property dialog is similar to the Microsoft Bind
dialog except that the Edit Property dialog visually indicates output properties with
an arrow icon .

To view cancel handlers and fault handlers
By default the design surface shows workflow activities. You can change the view of a
workflow to see a cancel handler or fault handlers.

1. From the View menu choose Commands Pane.

This command shows the Commands Pane and adds a few commands to the right-click
menu.

2. Select the item for which you want to view handlers and then choose View Cancel
Handler or View Fault Handlers:

● To view a handler for a particular activity, right-click the activity (on the design
surface). To return to the activity view, right-click the activity and choose View
ActivityName.

●

To view a handler for a Sequence Activity or Parallel Activity, click the 
Sequence Activity icon or Parallel Activity icon in the workflow. To return to

the activity view, click the same icon and choose View Sequence or View Parallel.
● To view a handler for the entire workflow, click the top node of the workflow

. To return to the activity view, click the top node and choose View Name.

Note: When you show the Commands Pane and right-click an activity on the design
surface, the menu includes some advanced commands: Generate Handlers, Promote
Bindable Properties, and Bind Selected Property. Those commands, also available
from the Commands Pane, are intended only for advanced users. For information on
those commands, refer to the Microsoft documentation.

To view workflow code
The code for a workflow is defined in an Extensible Object Markup Language (XOML) file.
You can view and edit that and other project files from the Workflow Studio Designer
window.

● Right-click the design surface and choose View Code.

Changing Your View of the Designer Window
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The XOML file opens in a new tab in the design surface area.

To view project files
You can access the project files, including the workflow code, that comprise a workflow
through the Workflow Studio Designer window.

1. From the View menu choose Project to open the Project tab.

2. To open a file in a new tab in the design surface area, double-click a filename in the
Project tab. The code for the workflow is in the .xoml.cs file.

Changing Your View of the Designer Window
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Working with Activities

The following topics describe tasks related to using activities in workflows.

● Customizing the Activities Tab

● Adding Activities to a Workflow

● Adding a Branch to a Parallel Activity

● Creating a Global Property

● Binding Activity Properties

● Starting a Workflow from Another Workflow

● Creating and Working with Snippets

● Creating an Activity without Writing Code

● Using the Delay Activity to Persist a Workflow

● Adding Custom Code to a Workflow

● Adding a Missing Component
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Customizing the Activities Tab

The Workflow Studio installation includes activities developed or extended by Citrix as well
as activities developed by Microsoft. Each activity is part of an activity library and each
library consists of one or more .dll files. Some activities are hidden by default.

Note: For information about developing activities, go to
http://community.citrix.com/cdn/wf/sdks and download the Workflow Studio Activity
Developer’s Guide.

To customize the Activities tab
● To add installed activities to the Activities tab, choose Tools > Choose Activities,

select the checkbox of the activity to be added, and then click OK.

● To remove an activity from the Activities tab, choose Tools > Choose Activities, select
the checkbox of the activity to be removed, and then click OK.

● To reset the list of activities in the Activities tab to the defaults, choose Tools >
Choose Activities, click Reset, and then click OK.

To install an activity library
Use the following procedure when an activity library does not have an installer.

1. Choose Tools > Choose Activities, click Browse, browse to the .dll file for that library,
and click Open.

2. In the Choose Activities dialog, click the Namespace column heading to sort the
activities by namespace.

3. Scroll to the namespace for the activity library you installed and select the checkbox
for each activity you want to appear in the Activities tab.

To add an activity from the Global Assembly Cache
(GAC)

1. Choose Tools > Choose Activities and then click Browse.

2. In the .NET tab, select the activity and click OK.

http://community.citrix.com/cdn/wf/sdks


To search for an activity in the Activities tab by name
● In the search bar at the top of the Activities tab, start typing the name. The list of

activities displayed is filtered by your input. Note that all folders continue to display.

Customizing the Activities Tab
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